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Object of Declaration:

EU Declaration of Conformity

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory
environment. This development/evaluation tool is not a Finished Appliance, nor is it intended for
incorporation into Finished Appliances that are made commercially available as single functional units to
end users under EU EMC Directive 2004/108/EC and as supported by the European Commission’s Guide
for the EMC Directive 2004/108/EC (8" February 2010}.

This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see
Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and
available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA

O~ Ay =12
Derek Carlson Date
VP Development Tools
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Preface

NOTICE TO CUSTOMERS

document.

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
Wi-Fi G Demo Board. Items discussed in this chapter include:

Document Layout

Conventions Used in this Guide

Warranty Registration

Recommended Reading

The Microchip Web Site

Development Systems Customer Change Notification Service
Customer Support

Document Revision History

DOCUMENT LAYOUT

This document describes how to use the Wi-Fi G Demo Board to create a Wi-Fi network
and control the demo board functions from the client device web browser.

The manual layout is as follows:

Chapter 1. “Overview” — This chapter provides a brief overview of the demo
board, highlighting its features and uses.

Chapter 2. “Hardware” — This chapter provides the hardware description of the
Wi-Fi G Demo Board.

Chapter 3. “Getting Started” — This chapter describes what you need to know to
start using the Wi-Fi G Demo Board.

Chapter 4. “Description of Modes of Operation” — This chapter provides the
modes of operation description of the Wi-Fi G Demo Board.

Chapter 5. “Programming” — This chapter describes what you need and how to
program the Wi-Fi G Demo Board.

© 2013 Microchip Technology Inc. DS50002147A-page 7

Downloaded from Elcodis.com electronic components distributor



http://elcodis.com/parts/6588725/DV102412.html

Wi-Fi G Demo Board User’s Guide

» Chapter 6. “Advanced Features” — This chapter describes the advanced fea-
tures such as changing transmit power.

» Chapter 7. “Customizing Web Pages” — This chapter provides the guidelines on
how to customize web page contents.

* Appendix A. “Wi-Fi G Demo Board Schematic” — This appendix includes the
Wi-Fi G Demo Board schematic.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

| Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris theradixand nis a
digit.

4'p0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OxFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var name [,
var name...]

Represents code supplied by
user

void main (void)

{
}

© 2013 Microchip Technology Inc.
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. Send-
ing in the Warranty Registration Card entitles users to receive new product updates.
Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user's guide describes how to use the Wi-Fi G Demo Board. The following
Microchip documents are available from the Microchip web site (www.microchip.com),
and are recommended as supplemental resources.

MRF24WGOMA/MRF24WGOMB Data Sheet (DS70686)

Microchip MRF24W Getting Started Quick Guide for MRF24WBOMA/B,
MRF24WGOMA/B for MLA v5 (DS52108)

PIC32MX5XX/6XX/7XX Family Data Sheet (DS61156)

TCPIP Stack Help.chm (This is bundled together with the TCIP/IP source code
releases.)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

DS50002147A-page 10 © 2013 Microchip Technology Inc.
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DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail notification whenever there are changes,
updates, revisions or errata related to a specified product family or development tool of
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

» Compilers — The latest information on Microchip C compilers, assemblers, linkers
and other language tools. These include all MPLAB C compilers; all MPLAB
assemblers (including MPASM™ assembler); all MPLAB linkers (including
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object
librarian).

* Emulators — The latest information on Microchip in-circuit emulators. This
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

* In-circuit Debuggers — The latest information on the Microchip in-circuit debug-
gers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 debug
express.

- MPLAB® IDE - The latest information on Microchip MPLAB IDE, the Windows®
Integrated Development Environment for development systems tools. This list is
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and
MPLAB SIM simulator, as well as general editing and debugging features.

* Programmers — The latest information on Microchip programmers. These include
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included
are nonproduction development programmers such as PICSTART® Plus and
PICkit 2 and 3.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

* Local Sales Office

 Field Application Engineer (FAE)
» Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at:
http://www.microchip.com/support

DOCUMENT REVISION HISTORY
Revision A (March 2013)

« |nitial Release of this Document.
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Chapter 1. Overview

1.1 INTRODUCTION

Thank you for purchasing the Microchip Technology’s Wi-Fi G Demonstration kit. The
Wi-Fi G Demo Board provides a low-cost and portable development system for
Microchip’s MRF24WGOMA IEEE 802.11b/g Wi-Fi Transceiver Module.

The Wi-Fi G Demo Board is preloaded with a demo software for the user to explore the
features of the MRF24WGOMA Wi-Fi module. It is also expandable through an 8-pin
expansion interface, which enables the user to extend its functionality by adding
various sensor expansion boards.

The topics discussed in this chapter include:

* Wi-Fi G Demonstration Kit Contents
* Functionality and Features

1.2 Wi-Fi G DEMONSTRATION KIT CONTENTS

The Wi-Fi G Demonstration Kit contains the following:
* Wi-Fi G Demo Board

» 2 AAA Batteries

* Male 1x6 Connector Header HDR-2.54 (J14)

* Wi-Fi G Demo Board Information Sheet (DS52107A)

1.3 FUNCTIONALITY AND FEATURES

The Wi-Fi G Demo Board supports the following network types:
* Infrastructure (client)

» Ad hoc

» Wi-Fi Direct (peer-to-peer as group client)

» SoftAP

The security modes supported are:

* Open

WEP-40, WEP-104 (Wired Equivalent Privacy)

» WPA (Wi-Fi Protected Access)

+ WPA2 (Wi-Fi Protected Access)

For ease of setup and usability, the following connection methods are also supported.

+ WPS-PBC (Wi-Fi Protected Setup Push Button Configuration)
* WPS-PIN (Wi-Fi Protected Setup Personal Information Number)

© 2013 Microchip Technology Inc. DS50002147A-page 13
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Note:

For Demo Version 1.02, only SoftAP, infrastructure and ad hoc network
support are offered. SoftAP supports only open and WEP security at this
time. All security modes are supported in other network types. Future
versions of the Demo software will include the additional functions noted
above.

A representation of the layout for the Wi-Fi G Demo Board is shown in Figure 1-1.

FIGURE 1-1:

Wi-Fi®

G DEMO BOARD LAYOUT
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Overview

The Wi-Fi G Demo Board has the following key features:

MRF24WGOMA |IEEE 802.11 b/g Wi-Fi Transceiver Module
PIC32MX695F512H 32-bit microcontroller

MCP1642 +3.3V Boost regulator

Three LED status indicators (LEDO - GREEN, LED1 - YELLOW, LED2 - RED)
One push-button switch for user input (SWO0)

Power ON/OFF slider switch (S1)

6-pin programming/debug port (J14)

8-pin expansion port (J15)

© Nk N =
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Chapter 2. Hardware

This chapter describes the hardware features of the Wi-Fi G Demo Board.

21 HARDWARE FEATURES

The key features of the Wi-Fi G Demo Board are listed below and are introduced in
Section 1.3 “Functionality and Features”. See Figure 1-1 for their locations on the
board.

211 MRF24WGOMA IEEE 802.11 b/g Wi-Fi Transceiver Module

The MRF24WGOMA IEEE 802.11 b/g Wi-Fi Transceiver Module provides wireless con-
nectivity to the demo board. Host communication is through SPI2 of the PIC processor
on the board.

21.2 Processor Support

The Wi-Fi G Demo Board is designed with a permanently mounted (soldered)
PIC32MX695F512H processor.

21.3 Power Supply

The board is powered by 2 AAA batteries. If required, the battery voltage is monitored
and boosted by the MCP1642 Synchronous Boost Regulator.

214 LEDs

The LEDs: LEDO (GREEN), LED1 (YELLOW) and LED2 (RED) are connected to
PORTE and PORTF of the PIC32MX695F512H processor. To turn the LEDs ON, the
port pins are set high.

21.5 Switches

The Wi-Fi G Demo Board has the following switches:

* S1 - Controls the main power to the board. To turn on the board, move S1 slider
to the ON position.

+ SWO0 - It is an active low push-button switch, connected to RD9 of the processor.
When idle, the switch is pulled high (+3.3V) and when pressed, it is grounded.

21.6 Programming/Debug Port

Connector J14 provides easy access to the PIC32MX695F512H processor’s debug
pins. This is used to program or reflash the demo board with new firmware.

21.7 Expansion Port

Connector J15 provides access to six of the processor’s spare I/O pins. These pins can
function as general purpose I/O ports or as an SPI, 12C or UART interface to an external
circuit design.

© 2013 Microchip Technology Inc. DS50002147A-page 17
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TABLE 2-1: J15 EXPANSION PORT PIN CONFIGURATIONS
Pin 1 Pin 2 Pin 3 Pin 4 Pin 5 Pin 6 Pin7 Pin 8 Interface
SCK +3.3V GND SDI SDO /1SS - SPI
- +3.3V GND SDA SCL - -+ 12c™
RTS +3.3V GND RX TX CTS - USART
X2 +3.3V GND RX1 TX1 RX2 -* DUAL
USART

* - Pins 7 and 8 may be used as GPIO or A2D (analog-to-digital) pins.

© 2013 Microchip Technology Inc.
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Chapter 3. Getting Started

3.1 OVERVIEW

The Wi-Fi G Demo application uses a network provisioning mechanism called
EasyConfig to enable configuration of an embedded device on a wireless network.
EasyConfig utilizes the web server of the TCP/IP stack and a wireless network to
enable the user to input the desired network information from a client browser, and then
reset the device to connect to the desired network.

3.2 RUNNING THE Wi-Fi G DEMO APPLICATION

This section describes how to connect to the Wi-Fi G Demo Board to control the on
board LEDs and view the status of the SWO0 switch from a web browser. It also
describes how to connect the Wi-Fi G Demo board to an existing network.

1. After turning the power on, the Wi-Fi G Demo Board broadcasts a SoftAP net-
work with an SSID, MCHP_G_xxxx, where, xxxx is the last four digits of the
MRF24WGOMA IEEE 802.11 b/g Wi-Fi Transceiver Module’s MAC address (See
Example 3-1).

EXAMPLE 3-1:

MRF24WGOMA MAC (SN): 001ECO01F102
SSID: MCHP G _F102

FIGURE 3-1: AVAILABLE WIRELESS NETWORKS

nohee_oo :&ﬂﬂ k
WiFi-User's Guest Network :ﬂjﬂ
MicrochipDemoAP .:ﬂﬂ
MBR1200B-f3f :qjﬂ

LedZepAP al

MCHP Ul
MCHP_G_f102 o

#! Information sent over this network
might be visible to others.

[[] Connect automatically =
r
113!“
',

L ™

Open Network and Sharing Center

Note: SoftAP is required to transmit beacons within each beacon interval. This
increases the transmit power consumption and therefore shorten the
battery life.
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2. Connect a client device (e.g., laptop, smart devices) to the MCHP G xxxx
SoftAP network.

3. When the client device is connected, use a standard web browser and enter the
IP address of the Wi-Fi G Demo Board. The default IP address is
http://192.168.1.3. Another alternative is to enter “mchpboard.local” into the web
browser. See figure Figure 3-2.

FIGURE 3-2: ACCESSING WEB BROWSER

£ -~ B & X | wiFi-G Demo Board %

File Edit View Favorites Tools Help

A \ - ~ 2 dmn v Pagev Safetyv Tools~ (@~

-

Q MICROCHIP Instead of using IP address, use assigned
host name mchpboard.local

WIiFi-G Demo Application

m Version: v1.00
MRF24WGOMA
]
ﬁ(;l;‘f:go:-};e welcome' LEDs: (Click LED to Toggle)
You are currently connected to:
s SSID name: MCHP_G_e935 Button Status:
e Security type (None, WEP, WPA, WPA2, ]

WPA-AUTO, WPS): None
* WLAN type: SoftAP (BSS)
* IP Address: 192.168.1.3
* RF module FW version: 3107

On the right you'll see the current status of the demo board. For a quick
example, click the LEDs to toggle the lights on the board. Press the push
button and you'll see the Button Status update immediately. This
examples uses AJAX techniques to provide real-time feedback.

4. The following web pages from the web server that is running on the Wi-Fi G
Demo Board are displayed.

a) The index.htm web page displays the additional information about the Wi-Fi G
Demo Board application. It also displays the continually updating status of the
three LEDs (LEDO, LED1 and LED2) and push-button on the Wi-Fi G Demo
Board, see Figure 3-3. To control the LEDs, click on the LED icon on the web
page. To see the status of the push-button, press SWO0 on the Wi-Fi G Demo
Board.
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FIGURE 3-3: SAMPLE INDEX.HTM WEB PAGE

A\ MicrocHip

WiFi-G Demo Application

m Version: v1.00
MRF24WGOMA

. Welcomel

You are currently connected to: &
# S5ID name: MCHP_G_e935 Button Status:
* Secunty type (None, WEP, WPA, WPAZ, A

WPA-AUTO, WPS): None
+ WLAN type: SoftAP (BSS)
» IP Address: 192.168.1.3
» RF module FW version: 3107

an the right you'll see the current status of the demo board. For a quick
example, click the LEDs to toggle the lights on the board. Press the push
button and you'll see the Button Status update immediately. This
examples uses AJAX techniques to provide real-time feedback.

There are three menu items on the left hand side. The first is the current
page you see, which shows the status of the LEDs and push button.

The second menu item (MRF24WGOMA), will display a page with
information about the 802.11b/g RF Transceiver Module being used for
this demo.

The third menu item (Configure Netwark), will display a page that will
allow you to scan for nearby networks, see them, and then connect to
another network. After the attempt is made to connect to the new
networl, you will have to transition your wireless PC, laptop, or
handheld wireless device to this new network in order to see that the
device has indeed changed networks.

Browser-based Device Configuration

This showcases how to configure and program an embedded Wi-Fi
device that does not have a natural keyboard and screen. By using the
internal webserver that accompanies the Microchip TCP/IP stack, end-
users can use their browser as a conduit for programming the device
with the correct network parameters.

For a wireless network, an end-user would need to have knowledge of at
least the following information:

* 551D name
s Security type (None, WEP, WPA, WPAZ, WPA-AUTO, WPS)
* Security key

&5 pioneered by most modern operating systems, the application also
has the ability to scan for all networks in the vicinity of the device, and
display them to the user. The user will also be given additional
information about the network such as whether security is enabled or
how far away the other network is. Users are also given the opportunity
to enter all the network information manually, which is required when
trying to connect to a network with a hidden S5ID.

Copyright & 2013 Microchip Technology, Inc.

b) Themrf24wgOma.htm web page highlights the features of the MRF24WGOMA
IEEE 802.11 b/g Wi-Fi Transceiver Module and the supporting development
tools. See Figure 3-4.
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FIGURE 3-4:

SAMPLE MRF24WGOMA . HTM WEB PAGE

@Mlumculp

WiFi-G Demo Application

R IEEE 802.11 - Wi-Fi®
MRFZAWGIMA
Onandlay

Configure
Network

Mcrochiy s scoes OU2. 11 whhems camTnications 2 ineug of wsens techvckoges (o the amosdse:
Mierchey s m WWiS1 PO deveicprman: etk aces 5021 cxpuisitien bo Lerochs
m.m;..“wrrn“::-’c.’al FUCTL, mnd caSIC fmmiy of micocoriroiers. The FiCsl

gt o conimr the MR ISANGOAA FOT e Wi carife mocus

T W FUTiml mkoea cesgrers b puicky crmse m Snec Conmeciion 3 e inbeme Gy s
Cormeciing bo standand SI2.1 G moosEs ponia. In managng the connecion, the MR 2RNGOMA mode

vy tee WA me bwmatred fars e i cormached bz tha hest 0L vis wn S5 pork. Tha &8 o T
Wicractas NG Fk remsies o i1 racrosto mvebegrrart e it TSP ey wmeh et
[y p—r—"

Hardwars Solutions

W F Medulea
POC and BT i v mothdes

WIS ZEWLONE, Bl POE arlema

WIS BSOS pupees sdeml ol

Esalursg:

= IEEE B02.11b'g compliant wirsle=s solution compatible with
Bfgi'm mout=rs

- Compatible with PIC1E, PICZ4, PIC3Z and d=PIC

controllers

« Supports Infrastrecture {dlient), Adhoc, SoftaP, WiFi- Direct
{group clienl) metworks

. MRFZ4WGEOMA small footprint moduls integrat=d antznna,
MALC, Bazeband, RF and power ampl

» MRFZAWGIMASE module is FOC, IC, Wi-Fi onrtified, and
ROHS, CE amd ETSL compliant, providing consid=rable cost
=avings and quick time-to-marde=t

» Lic=nz= Free TCP/TP stack supporting standard suite of
Inft=rm=t Services

« Provides Full IP s=rvic= funclions such a=s web s=rer, smail,
FTP, ICMP/DHCP serw ts, etc.

- Built-in E2Conflig application To Tacilitate network provisicning
without a keyboand or display

» Built-in ZzreConl {Bonjowr, &vahi) application to simplify
husman inberaction

» Supports WEP, WPA and WPAZ ==curity protocols on module

« Supports WPS-PBC and WPS-PIN connection methods

- Solution= a= simple a= a single PIC phes WiFi module with
power and passives,

Softwars Solutlons

JCEIE 23k whch oot W Can e cowntomter rom MicTChis ASEicicny Lienary. The s
inchien woarmpis appicaicrs Bch &3 WiF| demas wih SDCong and ZansCon funcior. s can mes i
TSI i TSR N L | (O N B DO SRS L0

F02.11 Developmant Tooks

AT TGS, W Pl ¢ Sictm B provicen 51211 oxmacinty Unng SIS mcacontrsiens o
Micrachips Seveicpmnt boers

Supporied Development Topls:

e FICORM .nei2 + ACIEA1E Prisl  Pictad Pz

L e o 1 + ACTES 4G Ficm | Ficm Pl

o FICIZ Siarier KE + 11T Sxpmnaion Goard + A/Z184155 Ficsl | Ficisd

Pz
L

Gocgiorer 18 + AC1851.53 Ficiml | Picial Pl

c) The conf

igure.htm web page enables the user to scan for nearby networks

and connect to the selected network to start up as a group client in Wi-Fi Direct
network, or as an ad hoc, or as a SoftAP and to select WPS-PBC or WPS-PIN.
See Figure 3-5.
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FIGURE 3-5: SAMPLE CONFIGURE.HTM WEB PAGE

A%\ MicrocHiP

Display Scan Results
MRF2AWGDOMA Scan for Wirgless Neaworks
Configure WPS Push Bution (WPS-PEC)
Network WES FIN (WPS-FIN)
Ad-Hoc
Soft AP

¥iFi Direct (group client role)

Other Metwaork...

|
|
|
J
|
|
|
J

WiFi-G Demo Application

Copyright © 2013 Microchip Technology, Inc.

5. To connect the Wi-Fi G Demo board to an existing network, click Display Scan
Results on the configure.htm web page. See Figure 3-6.

FIGURE 3-6: DISPLAY SCAN RESULTS WEB PAGE

A3\ MicrocHip

[ Display Scan Results

MRF24WGOMA KenHesky2

Configure guest
Network mchp-peap

guest
mchp-secure
MBR1200B-f3f
guest
Cisco55528
mchp-peap
mchp-secure
mchp-secure
nohee_yyy

WiFi-User's Guest
Network

AmyOng_AP
nohee_xxx
SMC
mchp-peap
guest
mchp-peap
guest
mchp-secure
mchp-secure
LedZepAP
mchp-peap
guest
mchp-secure

]

]

Scan for Wireless Networks

WPS Push Button (WPS-PBC)

WPS PIN (WPS-PIN)

Soft AP

‘WiFi Direct {group cliert role)

[
[
[
[ Ad-Hoc
[
[
(

Other Network...

J
J
J
J
J
J
J

WiFi-G Demo Application

Copyright @ 2013 Microchip Technology, Inc.

6. When a new network is selected, the Wi-Fi G Demo Board resets automatically
using the parameters (SSID, security key) of the new network to reconnect to this

new network. See Figure 3-7.
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FIGURE 3-7: RECONNECTION TO NEW NETWORK

AN nttp//mehpboard Jocal/recannect htm P - B ¢ X | A wiFi-G Demo Board

File Edit View Favorites Tools Help

o~ v =] mn v Page~v Safel

ﬁ'\ MICROCHIP

XTI  Reconnection in Progress

MRF24WGOMA A . :
— A connection to another network is now underway! You will need to
Configure connect this laptop/PC/portable device to the new network
Network ("AO_MicrochipDemoAP") to regain access to this demo.

As a reminder, this is the network you were on:

+ SSID: "MCHP_G_e90e"
+« WLAN type: SoftAP (BSS)

This is the network that you will be going to:

+ SSID: "AO_MicrochipDemoAP"
+« WLAN type: Infrastructure (BSS)

Copyright € 2013 Microchip Technology, Inc.

7. To continue using the demo, the client device must be reconnected to the same
network where Wi-Fi G Demo Board is redirected to.

Note: Thisis notapplicable forinitial release Demo Version 1.02. The demo board
always attempts to connect to the last known network. If the user wants to
reset the demo board to factory default conditions (startup in SoftAP mode)
again, then simply press SWO for 4 seconds. Do NOT press SWO0 immedi-
ately on power up, as this initiates a self-test and does not reset the demo
board to default factory conditions.
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Chapter 4. Description of Modes of Operation

41 SoftAP NETWORK

On starting the demo, the factory default conditions has the product start up as a
SoftAP without security. This means that all the network information that is being con-
figured on the device is going over-the-air in the open. For most applications, unless
another user is specifically attempting to listen in on this network, the potential security
impact is minor. However, for applications that require baseline level of security, WEP
can be employed on the network.

SoftAP is the centralized coordinator for the network. With MRF24WGOMA IEEE
802.11 b/g Wi-Fi Transceiver Module firmware version 0x3107 and future releases, it
supports Wired Equivalent Privacy (WEP) (40-bit/104-bit) security.

42 AD HOC NETWORKS

Ad Hoc networks are peer-to-peer networks with no centralized coordinator for the net-
work. All the devices share the responsibilities of keeping the network running. Accord-
ing to 802.11 specifications, ad hoc network only supports 802.11b rates of 1 Mbps, 2
Mbps, 5.5 Mbps and 11 Mbps.

One downfall of ad hoc networks is that typically security is not employed on them.

The MRF24WGOMA IEEE 802.11 b/g Wi-Fi Transceiver Module can secure an ad hoc
network with Wired Equivalent Privacy (WEP) (40-bit/104-bit) security, like most of the
laptops and ad hoc devices. Very few devices in the market can secure an ad hoc net-
work with Wi-Fi Protected Access (WPA) level security due to tremendous overhead.

For most applications, unless another user is specifically attempting to listen in on this
network, the potential security impact is minor. However, for applications that require
baseline level of security, WEP can be employed on the network.

Most Android devices do not support ad hoc networks.

4.3 Wi-Fi DIRECT NETWORKS

Wi-Fi Direct network is a peer-to-peer (P2P) network. It enables the user to configure
a secured wireless network between several devices, such as smart devices, laptops
or computers with wireless network adapters, without using an access point (AP).

Wi-Fi Direct supports Wi-Fi Protected Setup (WPS) connection method, which is
known as the WSC (Wi-Fi Simple Configuration) Config Methods in the Wi-Fi
Peer-to-Peer (P2P) Technical Specifications, in particular WPS Push Button method
with WPA2.

From the negotiation process, each device determines which devices become group
owner (GO) or group client (GC). The GroupOwnerintent field in the P2P information
element (IE) indicates the level of desire to become the GO. The higher the value, the
higher the desire to be the GO.

MRF24WGOMA IEEE 802.11 b/g Wi-Fi Transceiver Module only supports the role of
GC.

Wi-Fi Direct does not support 802.11b.
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44 ZERO CONFIGURATION/BONJOUR

Zero Configuration (Zeroconf) provides a mechanism to simplify the device configura-
tion on a network. The term Zeroconf is titled from the names Bonjour (Apple) and
Avahi (Linux), and is an Internet Engineering Task Force (IETF) standard. Zeroconf
provides simplified naming conventions, instead of relying on the IP addresses alone.

The Zeroconf is built on the following three core technologies:

4.41 Link Local

The first component of Zeroconf is the ability to self-assign an IP address to each mem-
ber of a network. Usually, a Dynamic Host Configuration Protocol (DHCP) server han-
dles such situations. However, when no DHCP server exists, Zeroconf-enabled
devices negotiate the unique IP address amongst themselves.

4.4.2 Multicast DNS

The second component of Zeroconf is the ability to self-assign the host names. Multi-
cast Domain Name System (mDNS) provides the local network with the ability to have
the features of a DNS server. User can use the host names to access the devices on
the network. When devices select to use the same host name, as in the IP address res-
olution, each of the devices has the ability to self-assign the Auto-negotiate New
Names, usually appending a number at the end of the name.

443 Service Discovery

The last component of Zeroconf is service discovery. All Zeroconf devices can broad-
cast what services they provide. For instance, a printer can broadcast about available
printing services. A thermostat can broadcast that it has an HVAC control service. For
a specific service, the user can see the list of devices that provide the service, and
connect to it. This eliminates the need to know whether something exists on a network
(and what its IP or host name is). The user can query the network to see if a certain
service exists or not, and easily connect to it.

444 Zero Configuration & mDNS demonstration

An iPhone and an apps supporting Zero Configuration is used in the demonstration.
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FIGURE 4-1: ZERO CONFIGURATION DOMAIN

wl AT&T 7 11:48AM 7 @ } 100% EZ

Click on the local domain and determine available services. See Figure 4-2.

FIGURE 4-2: SERVICE DISCOVERY

u AT&T 7 11:48AM 7 @ 3 100% EZF
A—

Domains

ocal

DemoWebServer

Click on the service offered, in this case, DemoWebServer. A web browser opens and
displays the Wi-Fi G Demo Board web pages. See Figure 4-3.

© 2013 Microchip Technology Inc.
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FIGURE 4-3:

DEMO WEB

BROWSER

ull ATET &

mchpboard.local./

X\ MicrocHin

Configure
Network

6:09PM 7 @ 3 100% EZ

WiFi-G Demo Board

=T

WIFi-G Demo Application!

Version: v1.00
1
Welcome! [P
You are currently connected
to: Button Status:
A

* SSID name:
AO_MicrochipDemoAP

* Security type (None, WEP, WPA, WPA2,
WPA-AUTO, WPS): None

* WLAN type: Infrastructure (BSS)

* IP Address: 192.168.1.104

* RF module FW version: 3107

On the right you'll see the current status of
the demo board. For a quick example, click
the LEDs to toggle the lights on the board.
Press the push button and you'll see the
Button Status update immediately. This
examples uses AJAX techniques to provide
real-time feedback.

There are three menu items on the left hand
side. The first is the current page you see,
which shows the status of the LEDs and
push button.

The second menu item (MRF24WGOMA), will
display a page with information about the
802.11b/g RF Transceiver Module being
used for this demo.

The third menu item (Configure Network),
will display a page that will allow you to
scan for nearby networks, see them, and
then connect to another network. After the
attempt is made to connect to the new
network, you will have to transition your
wireless PC, laptop, or handheld wireless

®* m @

4.5 CONFIGURED VS. UNCONFIGURED STATE

When the Wi-Fi G Demo is in an unconfigured state (i.e, serving the default
MCHP G xxxx SSID in SoftAP mode), the GREEN LED (LEDO) blinks twice per sec-
ond to indicate that it is not configured. After the network is configured, the LED blinks

once per second.

Note: When the Wi-Fi G Demo Board is moved to a different network, a new IP
address is assigned toit. As the new Wi-Fi G Demo Board does not display
the new IP address, the user must obtain the new IP address from the
server that assigned it. Refer to your server’s documentation for the neces-
sary steps required to obtain the new IP address.
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4.6 DETERMINING NEW IP ADDRESS ASSIGNED

There are two methods to determine the new IP address assigned:
a) Zero Configuration / mDNS

From the zero configuration apps, once this apps redirects and opens up the web
browser, the Wi-Fi G Demo web page shows the new assigned IP address. See
Figure 4-3.

b) AP DHCP ClientTable

Refer to your AP’s documentation for the necessary steps required to obtain the new
IP address. As an example, for certain APs, by selecting <Status> and then <Local Net-
work>, an option <DHCP Client Table> is offered. This DHCP Client Table lists the IP
address that is assigned to the Wi-Fi G Demo Board. See Figure 4-4.

FIGURE 4-4: DHCP CLIENT TABLE

]
CISCO. P 1.00

Linksys E1000 E1000

Access Applications &
Status Wireless security Rast s g Administration Status

T | Local Network |

Local MAC Address: CO:C1.C0:27:5A:9E
Router IP Address 192.168.1.1
Subnet Mask 255.255.255.0

|
DHCP Server Enabled
Start IP Address: 192.168.1.100
End IP Address: 192.168.1.149

DHCP Client Table

ToSortby  |PAddress v

ClientName | Interface 1P Address MAC Address Expires Time
SVDC-LT- r (" Delete |
15206 | LAN 192.168.1.116 | FODEF1E0:8A44) 234209 || Delete |

I Wireless-G | 192.168.1.117 |00:1E:CO:0CES E3 235948 Delete ‘

o
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NOTES:
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Chapter 5. Programming

51 SOFTWARE

The required software to program Wi-Fi G Demo Board include:

» Microchip MPLAB® X IDE
* Microchip MPLAB XC32 Compiler
Wi-Fi G Demo Board is based on the Microchip TCPIP stack software. You can down-

load the latest software version from the Microchip web site, as this contains the latest
bug fixes and the best support for current versions of the compilers.

Initial release is based on the Microchip TCPIP v5 stack software. Future plan is to add
this to Microchip TCPIP V6 stack software. Software updates are available on the
Microchip web site.

The initial release will only demo SoftAP with the capability to scan before connection,
enabling scan results to be available. From the scan results, another network can be
chosen to be redirected to.

Future releases will add more features such as Wi-Fi Protected Setup (WPS), etc.
Refer to the release notes for more information.

5.2 HARDWARE

The following hardware is required to program the Wi-Fi G Demo Board:

* In-circuit debuggers, emulators or programmers such as the PICkit™ 3, MPLAB
ICD 3 and MPLAB REAL ICE™ In-Circuit emulator.

In Figure 5-1, the MPLAB ICD 3 is used.
In Figure 5-3, the PICKkit 3 debugger is used.

* ICD 2 to ICSP Adaptor (Part number AC164110) is needed if the MPLAB ICD 3 or
MPLAB REAL ICE In-Circuit Emulator is used.

* Wi-Fi G Demo Board

» Power supply requirements:

- If programming using PICkit 3 or MPLAB ICD 3, power supply can be supplied
from the PICkit 3 or MPLAB ICD 3 itself.

- If using batteries during programming, note that multiple programming may
drain the batteries.

- +3.3V DC power supply may be needed if MPLAB X IDE is in debugging
mode.
The required hardware interconnections include:

* ICD 2 to ICSP Adaptor (Part number AC164110)

- Connect Wi-Fi G Demo Board J14 pin 1 to ICD 2 to ICSP Adaptor J2 pin1.
See Figure 5-2.

» PICkit 3

- Connect Wi-Fi G Demo Board J14 pin 1 to PICKit3 header pin 1. See
Figure 5-3.
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+ If external power supply is used:
- Supply Wi-Fi G Demo Board J14 pin 2 with +3.3V.
- Connect Wi-Fi G Demo Board J14 pin 3 to GND.

Otherwise, make sure 2 AAA batteries are present.

FIGURE 5-1: Wi-Fi® G DEMO BOARD — MPLAB® ICD 3 HARDWARE
INTERFACE

FIGURE 5-2: Wi-Fi® G DEMO BOARD - ICD 2 TO ICSP™ ADAPTOR
HARDWARE INTERFACE
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FIGURE 5-3: Wi-Fi® G DEMO BOARD - PICkit™ 3 HARDWARE
INTERFACE

"

Microcup

é

5.3 PROGRAMMING SEQUENCES - PROJECT

1. Open MPLAB X IDE.
2. Click on File>Open Project. Browse to Wi-Fi G Demo Board directory and open
Wi-Fi G Demo Board. See Figure 5-4.

FIGURE 5-4: OPEN Wi-Fi® G DEMO BOARD PROJECT

Wopenroje e .
- - - (3D wevan xioc ronum
ook (s Wi Goene s
gl . MPLAB X IDE Wiki
B e e >3
eses W Do Bowd
i e o
el Open a3 Man Project ||
- . I
“ My Documents
Computer.
| @ denome: [10\Sendooxes_AmyOng MU ManTrunk WiGDenoTCPIPIAR: G Demo\i G Demo Bow Open Project
‘! Hetwork Flesof type:  (project Foider Cancel

> L
. —
8 RAM Reserved: Producton Tmage e R RL ALY,
(& Flash 536560 (Dx327F0) bytes.
0%

3. Check the appropriate in-circuit debugger is selected. Click on <Project Proper-
ties>. See Figure 5-5. Ensure that right in-circuit debugger is selected. See

Figure 5-6.
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FIGURE 5-5: PROJECT PROPERTIES
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FIGURE 5-6: IN-CIRCUIT DEBUGGER SELECTION
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§ Compiler Toolchain @ SKDE PIC24H SENSOR
f F HC32 (v1.10) [C:\Progr  SKDE PIC32
=1 @ Merno # Starter Kits (PKO8)

= Other Tools

oy
& RAM 131072 (0x20000])
T % Licensed Debugger . = ,

B RAM Used: 0 (0x0)
5 RAM Reserved: Frogdll — *Tip: double diick on serial number (S) to use a friendly name (FN) instead.

= (@3 Flash 536560 (0x82FFO "~ Manage Configurations...
e

5 Flash Used: 0 (0x0) ; _
9 Flash Reserved: Prc [ cancal | ]

L & rascurces i | | |oppy | |tislp
@ Frogram BF Used: 0 Fi
 Data BP Usad: 0 Free:
& Data Capture BP: No 51
O SW @P: Disabled

=& Debug Tool

@ 10D 3: 121921851 T

1l b

«

4. Ensure that power switch S1 is set to ON. Select <Make and Program Device
(Project Wi-Fi_G_Demo_Board)>. See Figure 5-7.
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FIGURE 5-7:

MAKE AND PROGRAM DEVICE

¢ View Navigate Source Refactor Run Debug Tesm Took Window Help

oo, |

Make and Program Device (Preject WiFi G Demo Board)

(Project Wi

_M}é Quick Start

LT —

T) Take a Tour

& s

Output

W

".3 PICIMEISFS 12
8 Checkaum: 00 2003875
S Comper Tock
G ¥C32 (v1.00) [C:Program Fies (x36)acroc
Hemary
G RAM 131072 (0x20000) brtes
I . S
8 Rt Used: O () Free: 131072 (0200
58 RAM Reserved: Producson [mage
69 Flash 536560 (0x3270) bytes
 E—
8 Flach Used: 0 () Free: 536560 (0283
58 Flnch Reserved: Prochston tmage

A Resources
H Program B9 Used: 0 Frae: s

B oteeeces womtrians

ANl Tutorials =

= : watches.

Select this option to
make and program
Wifi G Demo Board

) rorums

(3 weran x ot Farum

© i

5. Wait for programming to complete. See Figure 5-8.

FIGURE 5-8:

PROGRAMMING IS COMPLETED

I
File Edit View Navigate Source Refactor Run Debug Team Tools Window Help
ol L I o N N
{WF_Configh @ (] MorDemo.c ®

@ || StartPage

) oy Fies
£ Lrker Fies
() Object Fies
i [ SoweeFies
- G Lorenes )
@ Loadables )
S5 auick stnt
L\ ST —
- -
=" -
: Output
WiFi G Demo Board (Build, Load, .) = | 1CD3 =
VWiF_G_Demo. Board - Dashboard o

D avision = 34300063

5 | O Deviee
& @ PICIDOESSFS L
@ 3 Chedum: (FAITETS

azes(s) will be prograrmed

T T
B S XC32 (v1.00) [C:VProgram Fies (x86) Mcroc
& Memory

(& RAM 131072 (0n20000) bytes
LR

S RAM Liged: 5901 (0x1519) Free: 125671
159 RAM Reserved: Producton Tmage
6 Fash 536560 (0x32°F0) bytes
%%

Programming/Verify compiste

88 Flash Uised: 213729 (DxIA2E1) Free: 32
8 Flogh Reserved: Prochucton Image
A Ressrces
[ Program 8P Used: 0 Free: 5
[ Data 8P Used: 0 Free: 2
© Bata Copture B: Mo Support
O SW 5P: Disabled
= 4§ Debug Tool
@ 1c0 3 Jm1zie21est

[ e viceon
& Diferances from MPLAD 8

All Tutorials >

® = |: warcnes.

addcens = Ox0, end address = 0x347£f

(\ Has completed programming

Wifi G Demo Board.

@ rorums

35 mpLan xme rorum

@ s wwcon
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54 PROGRAMMING SEQUENCES - HEX FILE

1. Open MPLAB X IDE.
2. Click on File>Import>Hex/ELF ..(Prebuilt) File.
See Figure 5-9.

FIGURE 5-9: IMPORT HEX FILE

3 MPLAB X IDE v1.30

@ Edit View Navigate Source Refactor Run Debug Team Tools Window Help

¥ New Project.. Ctri+Shift«N

Bge =

& Open Project... Cri+Shift+0
Open Recent Project
Import Hex/ELF... (Prebuilt) File
Open Team Project. MPLAB IDE v8 Project
Open File.
Open Recent File vy Quick Stan JE inuno videos 3 Forums
Project Group E s MPLAB IDE v8 Usars . IMPORTANT & Differances from MPLAB 8 () MPLAB X IDE Forum
I‘—> Take a Tour All Tutorials »> @ MPLAB X IDE Wiki

Q Download Compilers and Assemblers

Page Setup. Release Notes and Support Documentation

it i 3 |
Output

1 o« Mg oo

3. Browse to directory containing this HEX file. Select the correct device
<PIC32MX695F512H>. See Figure 5-10.
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FIGURE 5-10:

IMPORT HEX FILE — SELECT DEVICE PIC32MX695F512H

SIS

<No Project Opef

3 Import Image File
Steps Create Prebuilt Project
n
1. Create Prebuilt Project
2 Selectpr nd [Cerowse. |
Folder 0128 duction_v1-00.hex | [ R

3 summary
Famiy: Al Famiies, - IPLAB X IDE Forum
Device: -

[PIC32MX675F5 12L 7 IBPLAB X 1DE wiki

Supported Debug Prcsamxesss 2n

Header: [FIC32VX685F5 12L
IPIC32MK764F 128H
[PICI2MK 78 128L

Hardnare Todl;

fresancrzsF2seL
12
00 PICK3 [

[PICI2MNX775F256H Ex I

00 Real ICE

00 Smulator

Microchip Starter Kits

@ MCHY

@ MICROSTICK

9 SKDE 33AUDIO

@ SKDE Memory

@ SKDE PIC1F) o

o PM3 ‘5

mo_Board (Build, Load, .) x

4. Select the correct hardware tool (in-circuit debugger), for example PICkit 3. See

Figure 5-11.

FIGURE 5-11:

IMPORT HEX FILE — SELECT IN-CIRCUIT DEBUGGER

S

Projects

[ MPLAB X IDE VIS0 . -8 X |

vigate Source Refactor Run Debug Team Tools Window Help

@ x| StatPage ® EE

R Import Image File
Steps Create Prebuilt
1. Create Project
2 Ee]\::! Project ame and Prebuik Filenome: 00_01281 roduction_vi-00.hex Browse... I
older
3. Summary | K 10E Forum
Fomily: All Famdses -
Device PICIZMX695F512H - o 10€ Wiki
Supported Debug
Header:
Hardware Tool: Hardwiare Tools -
©oKD3
» FICR
oFM3 =
00 Real ICE E [ 3 |
Simulator o
Microchip Starter Kits
o MOV
3 MICROSTICK
3 SKDE 33 AUDIO
3 SKDE Memory
& SKDE PIC18F)
2 SKDE PIC24F 1 -
[EpT =14 D R
MPLREB X
| [Chet> ) Cancel
e =]

5. A Summary listing the Project Directory, Target Device, Platform Tool and Project
Source are displayed. Click on <Finish>. See Figure 5-12.

© 2013 Microchip Technology Inc.

Downloaded from Elcodis.com electronic components distributor

DS50002147A-page 37


http://elcodis.com/parts/6588725/DV102412.html

Wi-Fi G Demo Board User’s Guide

FIGURE 5-12:

IMPORT HEX FILE — COMPLETED

[ MPLAB XIDE v1.30

Navigate Source Refactor Run

File Edit View Debug Team Tools Window Help
i ?_Iu"él - 5 -5 PC: o) Qe se
[; proeets iz(E

@ x| Start Page =

Taxget Device
PICINOEISFS12E
Platform Teol
PICkic3PlatformTeol
Project Source

C:\Microchip\Sandboxes_AmyOng\WiFiGDemc\SW
Releases!\DemoVersionl.00_012813\WiFiGDemoBoard . production_vl-00. hex

Steps Summary
1. Create Frebuilt Project
2. Select Project Mame and Project Directory |
Folder 2
3 Summary A mew pre-built (lcadable image) preject will be created hera:
Cr\Microchip\Sandboxes_RmyOng\WiFiGDemo\SW IDE Forum
Releases\Demoversionl.00_012813\WiFaGDemoBoard. production_vl-00.X
1DE Wiki

MPLRE X

L

Power supply is supplied to Wi-Fi G Demo Board from the in-circuit debugger.
Under <Project Properties> and selected in-circuit debugger, click on Option
categories>Power. Enable option to <Power target circuit from PICkit 3> or
<Power target circuit from MPLAB ICD 3>. See Figure 5-13 and Figure 5-14.

FIGURE 5-13:

PICkit™ 3 POWER CONFIGURATION

gate So
g R
: Projects

[+]
L
bl

evice
@ PICIIMGISFSI2H
8 Chedksum: Debug Image
¥ Compiler Toolchain
)

@ Memory
= () RAM 131072 (0x20000]
E—‘_Lns,

5 RAM used: 0 (0x0) H

& Flash 536560 (0xB2FFD)
0%

5 Flosh Used: 212049
B Flash Reserved: o
4 Resources
E Program BP Uised: 0 F
© Data B Used: 0 Free:
S Dota Capture 8P o Sug
D SW BP: Ho Support

#4 Debug Tool
EYeiaas

Refactor Run Debug

defoult T B -

B RAM Reserved: 509 i

Team Tools W

|: ardproducti.. @8 || StartPage x
%% s WiFGDemoBoard.production_v1-g |

Learn & Discover
& Project Properties - WiFiGDemoBoard.production_v1-00

Categories:
> General
> conf: [defaut)

Option categories;  Power >,

Pover target circuit from PICKIt3 -
Waltage Level

I L8 X1 1130 WiGDemotosdprcycton 10 ot TN = (75

AB X IDE Forum

AB X IDE Wiki

Option Description | Programmer To Go

Manage Configurations...

Help
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FIGURE 5-14: MPLAB® ICD 3 POWER CONFIGURATION

B MPLAB X IDE v1.30 - WiFi_G_Demo_Board : d
File_ Edit View Navigate Source Refactor Run Debug Team To
B . AT 8- R-2-VB- 00006 m
: Projects

2[5 wrs bemo soard

[ defaut

IE
£

@) Header Fiks
s (& wmportant Fies
8 (@) ubrary Fies
o 6 Lirker Fies

[ obiectFies

) Source Fies
& ubraries

==

3 Project Properties - WiFi_G_Demo_Board. )

Y

(& Loadables o ——
Categores: = =
g Options for 1cD 3
2 Conf; [defalt) Option categories: | Power. =
io 13
o Loadin e Oiviser
T oer target craut from 10D 3 |= L
o Buidng joltage Level |325 =
ol If
 WiFi_G_Demo_Board - Dashboard. Lo xcazas
3 78 WP _G_bemo Board o xca2gee
2 S @ pevce o xa2u
@ G PICIMXEISFS12H o
é 4 Checksum: 0xFTDE3875

H Compier Toolchain :
' G XC32 (v1.20) [C: Program Files (x86) Wicrochip\
59 vemory

£ RAM 131072 (0x20000) bytes
e}

RAM Used: 0 (0x0) Free: 131072 (0x20000)
RAM Reserved: Production Image
5 (53 Flash 536560 (0x82FF0) bytes

Option Description

sh Used: 0 (0x0) Free: 536560 (0xB2FFD),
sh Reserved: Prodiuction Image

@ re
5 Program B Lsed: 0 Free: 6
5] Dota BP Used: 0 Free: 2
D Data Capture B: No Support
O 5w BP: Discbied

£ Debug Tool
© 103 221951

Manage Configurations.

7. Click on <Make and Program Device>. See Figure 5-15.

FIGURE 5-15: MAKE AND PROGRAM DEVICE

K 18 x 10 130 WiGORmoowaacon 138 - -

File Edit View Navigate Source Refactor Run Debug Team T,

% £ & st S Q-
Projects ardproducti.. @ X || Start Page %

FRYR v GDemoBosrd. production_v1-(

= e

bt ’ PIC3ZMX69SFS12H

3 Checksum: Debug Image
T Compiler Toolchain

¥ ()
@ Memory

& RAM 131072 (0x20000) byl

%
&5 RAM Used: 0 (0xD) Fre(
8 RAM Reserved: 509 byt

= (@ Flash 536560 (0XB2FF0) by
40%

8 Flash Used: 212949 (0%
8 Flash Reserved: None
4@ Resources
© Program BP Used: 0 Free:
@ Data BP Used: 0 Free: 2
© Data Capture 8F: No Suppx
O SW BP: No Support

=1

3 " Quick Start

G MPLAB IDE v8 Users - IMPORTANT

I Take a Tour

@ Download Compilers and Assemblers.

4 Debug Tool
O PiCts Release Notes and Support Documentation
Output - WiIFIGDemoBoard.production_v1-00 (Load)
ading code frem C:\Nieroenip
aration Bits: address Ox
Loading completed
‘ »

PG\ F1GDemo\ 5%

B 11inute videos

& Differences from MPLAB &

Al Tutorials >>

@ % ; Tasks

(. Forums

(XD MPLAB X IDE Forum

0 MPLAB X IDE Wiki

3\N1FiGDemcBosrd. production
e device database

Setting it to the defeult v

8. Once programming is completed, the output panel displays programming com-

pleted status. See Figure 5-16.
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FIGURE 5-16:

PROGRAMMING COMPLETED

K MPLAB X IDE

S default
Projects ardproducti.. @ %
s WIFIGDemoBoard.production_v1-0
P Device
P PICIIMXESSFS12H
M Checksum: (XFA39060C
T Compiler Tookhain

Memory
& RAM 131072 (0:20000) byl
0%

5 RAM Used: 0 (0x0) Freq
B8 RAM Reserved: Product
& Flash 536560 (0xB2FFO)

@

(L] K

9 Flash Used: 0 (0x0) Fre
8 Flash Reserved: Produc

4 Resources
& Program BP Used: 0 Free:

= - R-QH-

Start Page =

_% Quick Start

@ MPLAB IDE v& Users . IMPORTANT

? Take a Tour
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PC: 00 Q-

D Forums

(%) MPLAB X IDE Forum

e MPLAB X IDE Wiki

A e e
File Edit View Navigate Source Refactor Run Debug Team Tools Window Help

B Dota 8P Usad: 0 Free: 2
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O 5w 8P: No Support 4 (1 k .
4K Debug Tool
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© Press Refresh Debug Tool § WiFiGDemoBoard.production_v1-00 (Load, Run) = PICkit3 x
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Chapter 6. Advanced Features

6.1 CHANGE TRANSMIT POWER
Wi-Fi APIs are available in source file WEFTxPower . c to read and write MRF24WGOMA
transmit power. MRF24WGOMA has a transmit power range of 0 dBm to 18 dBm.

Invoke function prototype WF_TxPowerGetMax to read back MRF24WGOMA transmit
power. Invoke function prototype WF_TxPowerSetMax to set MRF24WGOMA transmit
power. No conversion of units is needed as input parameter to WF_TxPowerSetMax is
in dBm.
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NOTES:
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Chapter 7. Customizing Web Pages

7.1 SOFTWARE REQUIREMENTS
* Microchip MPLAB X IDE

7.2 DIRECTORY LOCATION

WiFiGDemo web pages are contained within MPLAB WiFi G Demo Board project.

FIGURE 7-1: Wi-Fi® G DEMO BOARD MPLAB® PROJECT DIRECTORY

|§ Projects .
=3 WiFi_G_Demo_Board

+E Header Files

+ﬁ‘ Important Files

+E Library Files

+ﬁ Linker Files
-(F] Object Files
+ﬁ1 Source Files
g WifiGDemo\WebPages
..... [@] configure.htm
_E 55

% mchp.css
----- @ error.htm
----- @ index. htm
—[ai Jjavascript
@ mchp.js

----- @ mrf24wgima.htm
----- @ reconnect.htm
+- [ Libraries
+@ Loadables

» Execute or run batch file, based on MPFS utility MPFS2 . jar, to compile HTM files
into @ WiFiGDemoMPFSImg. c image

\TCPIP\WiFiGDemo\Convert WebPages to MPFS.bat
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This batch file will output five files upon successful completion.
- WiFiGDemoMPSFSImg.bin

- WiFiGDemoMPFSImg.c (used by Wi-Fi_G_Demo_Board proj-
ect)

- WiFiGDemoMPFSImg. s
- HTTPPrint.c
- HTTPPrint.idx

* Wi-Fi G Demo HTM files

\TCPIP\WiFiGDemo\WiFiGDemoWebPages

Web Pages
e index.htm
e mrf24wgOma.htm
e configure.htm
e error.htm
* reconnect.htm
+ Javascript file
\TCPIP\WiFiGDemo\WebPages\javascript\mchp.js
» Source code files (where HTM files and stack source codes interacts)
\TCPIP\WiFiGDemo\customHTTPApp.cC

7.3 STEPS FOR CUSTOMIZING WEB PAGE CONTENTS

This section illustrates customizing web page contents by adding a new field entry <RF
module FW version>to index.htm.

1. Click on the selected HTM file to view the original un-modified web page. For
example, index.htm. See Figure 7-2.

FIGURE 7-2: ORIGINAL UN-MODIFIED INDEX.HTM

@ MICROCHIP

WiFi-G Demo Application

m Version: ~Demoversion~
MRF24WGOMA

i Tame Welcome!

| Error:

: Connection to

: demo board was

* SSID name: ~ssid~ lost.

® Security type (None, WEP, WPA, WPAZ,
WPA-AUTO, WPS): ~curPrivacy~

s WLAN type: ~wlan~

® 1P Address: ~ipaddr~

Network

You are currently connected to:

On the right you'll see the current status of the demo board. For a quick
example, click the LEDs to toggle the lights on the board. Press the push
button and you'll see the Button Status update immediately. This
examples uses AJAX techniques to provide real-time feedback.

There are three menu items on the left hand side. The first is the current
page you see, which shows the status of the LEDs and push button.

2. Open index.htm. Create a new entry by adding the following line:
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<1i>RF module FW version: <b> fwver~</b><1li>
Save the file. See Figure 7-3.

FIGURE 7-3: INSERT NEW ENTRY INTO INDEX.HTM

6 MPLAB X iDE vI30 - Wi 6.

File_Edit View Havigate Sour

ebug Team Tools Window Help

T D AT BT R

g [fpropects @ n| StrtPoge m (V]L0Pc m![6) confiowehtm m[[8) indexhim | EREE
J 5@ weioeopewd BE-2-AaSfEfrosaulen

| HesderFies

Y o rectantres . .
i =
i

VAFLG_Demo_Board - Dashbosra @ %
3 ['s We_5_bemo_foard .
P oevice

e
' 8 Checksum: 07083875

e internal webserver That accompanies
m o7 Compler Tookhan
F XC32 (v1.00) [CtProgram Fie 2
Memory 8 g o Output ® = watches Vanables.
& (@9 RaM 131072 (0x20000) bytes
[

=
58 A Used: 0 (0] Free:
58 RAM Reserved: Productr| -
59 Flash 536560 (x62570) bytex
o

8 Flash Used: 0 (0x0) Free:
8 Flash Reserved: Productio
@ Resources
£ Program B9 Used: 0 Free: §
1 Data B Used: 0 Free: 2
1 Data Caphure &P N Suopart
O 54 B8 Diabied
=R

Debug Toe!
3 100 3: JIT121921851

11 s

3. Click on the modified index.htm to view the changes. See Figure 7-4.

FIGURE 7-4: MODIFIED INDEX.HTM

@ MICROCHIP

WiFi-G Demo Application

Version: ~Demoversion~

Welcome!

LEDs: (Click LED to Taggle]

You are currently connected to:

e SSID name: ~ssid~ Button Status:
® Security type (None, WEP, WPA, WPA2, ?

WPA-AUTO, WPS): ~curPrivacy~
* WLAN type: ~wlan~

o 1P Address: ~ipaddr~
I * RF module FW version: ~fwwver~ I
On the right you'll see the current status of the demo board. For a quick
example, click the LEDs to toggle the lights on the board. Press the push

button and you'll see the Button Status update immediately. This
examples uses AJAX techniques to provide real-time feedback.

There are three menu items on the left hand side. The first is the current
page you see, which shows the status of the LEDs and push button.

Thea carnnd meann item (MRFZAWGAMAY will dienlav a2 nane with

4. For new added functions, such as <RF module FW version>, the corresponding
files may need to be changed.
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* CustomHTTPApp.cC

//
//
//
void HTTPPrint fwver (void)

{

= Sends the FW version =

static BOOL firstTime TRUE;
static tWFDeviceInfo devicelInfo;
BYTE fwVerString[8];

if
{

(firstTime)
firstTime = FALSE;
WE GetDevicelInfo (&devicelnfo);
continually

// only call this once, not

}

uitoa ((deviceInfo.romVersion << 8) |
fwVerString) ;
TCPPutString (sktHTTP,

deviceInfo.patchVersion,

fwVerString) ;

—

5. Run the batch file <Convert WebPages to MPFS.bat> to generate a new
WiFiGDemoMPFSImg.c image

6. Rebuild the project. In the build process, the project uses Wi FiGDemoMPF -
SImg.c.

7. Connect to the WiFiG-Demo network. The changes are reflected on the
WiFi-GDemo web page.

FIGURE 7-5: NEW Wi-Fi® G DEMO WEB PAGE

A\ MicrocHip

WiFi-G Demo Application

Welcome! Version: v1.00
MRF24WGOMA
. Welcome!
Configure - LEDsS:  (=vski29ts Tasgk
Network .
You are currently connected to: ®
* 551D name: MCHP_G_e935 Button Status:
* Security type (None, WEP, WPA, WPA2, A

WPA-AUTO, WPS): None
* WLAN type: SoftAP (BSS)

* RF module FW version: 3107

On the right you'll see the current status of the demo board. For a quick
example, click the LEDs to toggle the lights on the board. Press the push
button and you'll see the Button Status update immediately. This
examples uses AJAX techniques to provide real-time feedback.

There are three menu items on the left hand side. The first is the current
page you see, which shows the status of the LEDs and push button.

The second menu item (MRF24WGOMA), will display a page with
information about the 802.11b/g RF Transceiver Module being used for
this demo.
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Appendix A. Wi-Fi G Demo Board Schematic

A1 INTRODUCTION
This appendix shows the Wi-Fi G Demo Board Schematic.
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FIGURE A-1: Wi-Fi® G DEMO BOARD SCHEMATICS
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Itasca, IL

Tel: 630-285-0071
Fax: 630-285-0075

Cleveland
Independence, OH
Tel: 216-447-0464
Fax: 216-447-0643
Dallas

Addison, TX

Tel: 972-818-7423
Fax: 972-818-2924

Detroit

Farmington Hills, Ml
Tel: 248-538-2250
Fax: 248-538-2260

Indianapolis
Noblesville, IN

Tel: 317-773-8323
Fax: 317-773-5453

Los Angeles
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608

Santa Clara

Santa Clara, CA
Tel: 408-961-6444
Fax: 408-961-6445

Toronto
Mississauga, Ontario,
Canada

Tel: 905-673-0699
Fax: 905-673-6509

ASIA/PACIFIC

Asia Pacific Office
Suites 3707-14, 37th Floor
Tower 6, The Gateway
Harbour City, Kowloon
Hong Kong

Tel: 852-2401-1200
Fax: 852-2401-3431
Australia - Sydney
Tel: 61-2-9868-6733
Fax: 61-2-9868-6755
China - Beijing

Tel: 86-10-8569-7000
Fax: 86-10-8528-2104

China - Chengdu

Tel: 86-28-8665-5511
Fax: 86-28-8665-7889
China - Chonggqing
Tel: 86-23-8980-9588
Fax: 86-23-8980-9500

China - Hangzhou
Tel: 86-571-2819-3187
Fax: 86-571-2819-3189

China - Hong Kong SAR
Tel: 852-2401-1200
Fax: 852-2401-3431
China - Nanjing

Tel: 86-25-8473-2460
Fax: 86-25-8473-2470
China - Qingdao

Tel: 86-532-8502-7355
Fax: 86-532-8502-7205
China - Shanghai

Tel: 86-21-5407-5533
Fax: 86-21-5407-5066

China - Shenyang
Tel: 86-24-2334-2829
Fax: 86-24-2334-2393

China - Shenzhen
Tel: 86-755-8203-2660
Fax: 86-755-8203-1760

China - Wuhan

Tel: 86-27-5980-5300

Fax: 86-27-5980-5118
China - Xian

Tel: 86-29-8833-7252

Fax: 86-29-8833-7256

China - Xiamen

Tel: 86-592-2388138
Fax: 86-592-2388130
China - Zhuhai

Tel: 86-756-3210040
Fax: 86-756-3210049

ASIA/PACIFIC

India - Bangalore
Tel: 91-80-3090-4444
Fax: 91-80-3090-4123

India - New Delhi
Tel: 91-11-4160-8631
Fax: 91-11-4160-8632

India - Pune
Tel: 91-20-2566-1512
Fax: 91-20-2566-1513

Japan - Osaka
Tel: 81-66-152-7160
Fax: 81-66-152-9310

Japan - Yokohama
Tel: 81-45-471- 6166
Fax: 81-45-471-6122

Korea - Daegu
Tel: 82-53-744-4301
Fax: 82-53-744-4302

Korea - Seoul

Tel: 82-2-554-7200
Fax: 82-2-558-5932 or
82-2-558-5934

Malaysia - Kuala Lumpur
Tel: 60-3-6201-9857
Fax: 60-3-6201-9859

Malaysia - Penang
Tel: 60-4-227-8870
Fax: 60-4-227-4068
Philippines - Manila
Tel: 63-2-634-9065
Fax: 63-2-634-9069
Singapore

Tel: 65-6334-8870
Fax: 65-6334-8850

Taiwan - Hsin Chu
Tel: 886-3-5778-366
Fax: 886-3-5770-955
Taiwan - Kaohsiung
Tel: 886-7-213-7828
Fax: 886-7-330-9305
Taiwan - Taipei

Tel: 886-2-2508-8600
Fax: 886-2-2508-0102
Thailand - Bangkok

Tel: 66-2-694-1351
Fax: 66-2-694-1350

EUROPE

Austria - Wels

Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4450-2828

Fax: 45-4485-2829
France - Paris

Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79
Germany - Munich
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44
Italy - Milan

Tel: 39-0331-742611
Fax: 39-0331-466781

Netherlands - Drunen
Tel: 31-416-690399
Fax: 31-416-690340
Spain - Madrid

Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
UK - Wokingham

Tel: 44-118-921-5869
Fax: 44-118-921-5820
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